Elecard StreamEye v.4.5
User Guide
User Guide Notices
Elecard StreamEye v.4.x User Guide
First edition: March 2013
Date modified: January 15, 2019.
For information, contact Elecard.
Tel: +7 (3822) 488-580.
More information can be found at: https://www.elecard.com
For Technical Support, please contact the Elecard Technical Support Team: tsup@elecard.com

Elecard provides this publication “as is” without warranty of any kind, either expressed or implied. This publication may contain technical inaccuracies or typographical errors. While every precaution has been taken in the preparation of this document, the publisher and author assume no responsibility for errors or omissions. Nor is any liability assumed for damages resulting from the use of the information contained herein. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. Elecard may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time.
Other company, product, trademarks, and service names are trademarks or service marks of other companies or corporations.
Copyright © 2013-2019 Elecard. All rights reserved.
CONTENTS

1. INTRODUCTION ........................................................................................................................................... 4
   1.1 PREFACE .................................................................................................................................................. 4
   1.2 USING THIS GUIDE .............................................................................................................................. 4
      1.2.1 Purpose ........................................................................................................................................ 4
      1.2.2 Abbreviations and Terminology ................................................................................................. 4
      1.2.3 Topics Covered ............................................................................................................................... 5
      1.2.4 Related Documentation ................................................................................................................ 5
   1.3 SYSTEM REQUIREMENTS ..................................................................................................................... 5
      1.3.1 Hardware Requirements .............................................................................................................. 5
      1.3.2 Software Requirements ............................................................................................................... 5
   1.4 LICENSING AND TECHNICAL SUPPORT .......................................................................................... 6
   1.5 ACTIVATING ELECARD STREAMEYE ............................................................................................... 6

2. GETTING STARTED ......................................................................................................................................... 9
   2.1 INSTALLING ELECARD STREAMEYE ................................................................................................. 9
   2.2 UNINSTALLING ELECARD STREAMEYE ............................................................................................ 9
   2.3 RUNNING ELECARD STREAMEYE ...................................................................................................... 9

3. DESCRIBING ELECARD STREAMEYE ...................................................................................................... 10
   3.1 OVERVIEW ........................................................................................................................................ 10
   3.2 SPECIFICATIONS ................................................................................................................................. 10
   3.3 FEATURES ......................................................................................................................................... 10

4. USING ELECARD STREAMEYE ................................................................................................................ 12
   4.1 INTRODUCTION .................................................................................................................................. 12
   4.2 DESCRIBING ELECARD STREAMEYE GUI ...................................................................................... 12
      4.2.1 ToolBars ..................................................................................................................................... 12
      4.2.2 Navigation Controls ...................................................................................................................... 15
      4.2.3 Comments Panel .......................................................................................................................... 17
      4.2.4 Stream Panel ............................................................................................................................... 18
      4.2.5 Stream Viewer ............................................................................................................................. 18
      4.2.6 Message Panel ............................................................................................................................. 19
      4.2.7 Buffer Panel ................................................................................................................................. 19
      4.2.8 Hex Viewer .................................................................................................................................. 20
      4.2.9 Picture Panel ................................................................................................................................ 21
      4.2.10 Headers ...................................................................................................................................... 22
      4.2.11 DPB Panel ................................................................................................................................... 22
      4.2.12 Statistics Panel ........................................................................................................................... 23
      4.2.13 Video Out Panels ....................................................................................................................... 24
      4.2.14 Overlay Panel ............................................................................................................................ 25
      4.2.15 Block Presenter Panel ................................................................................................................ 26
      4.2.16 Block Info Panel ......................................................................................................................... 27
      4.2.17 Pixels Panel ................................................................................................................................ 28
      4.2.18 Options Dialog ............................................................................................................................ 29
      4.2.19 Preview Dialog ............................................................................................................................ 36
      4.2.20 Hot Keys ..................................................................................................................................... 37
      4.2.21 Command Line Tool .................................................................................................................. 38
      4.2.22 Comparison Table ....................................................................................................................... 45
1. Introduction

1.1 Preface

Elecard StreamEye is a powerful software tool designed for professionals and prosumers in video compression field. Elecard StreamEye enables the user to perform an effective in-depth analysis of video sequences.

Elecard StreamEye supports elementary video streams such as MPEG-1/2, AVC, HEVC, VP9, AV1, which can be opened directly from MPEG-1 System Streams (SS), MPEG-2 Program Streams (PS) and MPEG-2 Transport Streams (TS) and from such popular container formats as AVI, MP4, MKV (WebM), FLV and IVF (in case of VP9 and AV1).

There are two versions of Elecard StreamEye:
- StreamEye Basic with limited functionalities which can be purchased as a standalone application
- Full featured StreamEye (or full version) which can be purchased as a standalone application or as a part of StreamEye Studio.

Automated analysis and standard compliance check are available with the command line tool of StreamEye full featured version. Configuration via XML-file provides an easy and flexible way to pick specific information from the processed stream and save it into CSV-files or into YUV RAW data in case of video data.

See a comparison table of basic and full-featured versions at the end of the document.

1.2 Using this Guide

1.2.1 Purpose

This guide is intended to help video encoder developers, SoC designers and consumer electronics vendors to analyze video bitstreams (including AVC/H.264, HEVC/H.265, VP9 and AV1 streams).

1.2.2 Abbreviations and Terminology

The following section defines the terms used throughout this document.

Blocks:
- **CTU** – coding tree unit is used for HEVC format, **Macroblock** is used for MPEG-1/2 and AVC, and **Superblock** is used for VP9 and AV1. This parameter includes the subblocks:
  - **CU** – coded unit;
  - **PU** – prediction unit;
  - **TU** – transform unit.

Metric types:
- **PSNR** – Peak Signal-to-Noise Ratio.
- **APSNR** – average values of PSNR results calculated for a sequence and based on mean values of MSE results.
- **VQM** – Video Quality Measurement Techniques – a metric designed to calculate video quality and measure perceptual effect of video distortions.
- **SSIM** – Structural SIMilarity. This metric is based on measuring three components (luminance similarity, contrast similarity and structural similarity) and combining them into result value.
- **DELTA** – the value of this metric is the mean difference of the color components in the...
correspondent points of image.

- **MSE** – Mean-squared-error based metric.
- **MSAD** – the value of this metric is the mean absolute difference of the color components in the correspondent points of image.
- **VMAF** - Video Multimethod Assessment Fusion is an objective full-reference video quality metric developed by Netflix in cooperation with the University of Southern California.
- **VMAF phone** – a metric designed to predict the quality of videos displayed on mobile phones.
- **NQI** – New Quality Index - is a metric designed to calculate video quality by combining three components: correlation loss, luminance and contrast distortion.

**Raw data:**
- **I444, I422, IYUV, NV12, NV21, P444, RGB24, RGB32, UYYV (Y422, UYNY, HDYC), V210, V400, V444, Y42B, YUY2 (YUNV, V422, YUYV), YV12, YV16, YYVU, Y4M.**

For additional information about raw data types follow the link: fourcc.org.

### 1.2.3 Topics Covered

The following lists the topics covered in this document:

- **Section 1: Introduction** – provides a general overview of the Elecard StreamEye program and describes the purpose of the document and its contents.
- **Section 2: Getting Started** – describes how to install, uninstall, and run the Elecard StreamEye program.
- **Section 3: Describing Elecard StreamEye** – provides a detailed description of the Elecard StreamEye program including features and supported stream formats.
- **Section 4: Using Elecard StreamEye** – describes the Elecard StreamEye GUI.

### 1.2.4 Related Documentation

For additional information, review the following documents:

- ISO/IEC 11172-2 for MPEG-1 video
- ISO/IEC 13818-2 for MPEG-2 video
- ISO/IEC 14496-10 for AVC/H.264 video
- ISO/IEC 23008-2 MPEG-H Part 2
- ITU-T Recommendation H.265
- A VP9 Bitstream Overview for Google VP9
- AV1 Bitstream & Decoding Process Specification

### 1.3 System Requirements

### 1.3.1 Hardware Requirements

- 4 GB RAM for video resolution below HD,
- 8 GB RAM for HD video (or higher).

### 1.3.2 Software Requirements

- Ubuntu 16.04 LTS, x64;
- CentOS 7.6 x86_64.
1.4 Licensing and Technical Support

By installing, copying, or otherwise using the software product or any updates, you agree to be bound by the terms of the "Elecard" End-User License Agreement ("EULA"). This EULA is a legal agreement between you (either an individual or a single entity) and Elecard for the "Elecard" software product(s) accompanying this EULA, which include(s) computer software and may include "online" or electronic documentation, associated media, and printed materials ("software product").

For technical support, please contact Elecard Technical Support Team: tsup@elecard.com
For sales and licensing information, contact Elecard Sales Department: sales@elecard.com

1.5 Activating Elecard StreamEye

Make sure that Sentinel License Manager software has been installed on your computer. License Manager is provided within the product installation pack for Windows OS and macOS and installed automatically.
License Manager is provided as a separate installation pack for Linux OS and should be installed manually.

Please note, Linux OS reinstallation will make the activated product license invalid.

To check that License Manager is properly installed, go to Sentinel Admin Control Center at http://localhost:1947. If you see your license information, the installation is successfully completed.

![Sentinel Admin Control Center](image)

Figure 1. The License Manager with license information

License Manager allows configuring, controlling, monitoring and looking through a list of available licenses. For more details on License Manager operation click the Help tab.

Note, each page contains the Help tab related to this page only.

There are two ways to activate Elecard StreamEye: on-line and offline.

On-line activation

1. Be advised, that Internet connection is required for this type of activation.
2. Your purchase confirmation e-mail will contain a product key serial number for on-line
activation. Make sure you inform your account manager that you are looking to activate the product on-line.

3. Enter the received product key XXXXXXXX-XXXX-XXXX-XXXX-XXXXXXXXXXXXX in the On-line activation with a product key field, as shown below, and click Activate. Your application is successfully activated.

![On-line activation with product key](image)

**Offline activation**

For Elecard StreamEye activation, a C2V (client-to-vendor) file should be created. To create the C2V file follow the steps:

1. Open the **File** tab and select **Options** in the drop-down menu.
2. A dialog window should open. Open the **License** tab.
3. Select HASP-SL for PC-based or HASP-HL for dongle-based activation in the **Offline activation with license files** field. Note, if you select a PC-based (HASP-SL) activation, full featured activated Elecard StreamEye will run only on this particular hardware. If you have Elecard dongle, plug it into a free USB port on your computer and select dongle-based (HASP-HL) activation. It will be possible to use Elecard StreamEye on any hardware with the dongle plugged in.

![Offline activation with license files](image)

4. Click the **Collect license information** button. The Save File dialog box should open. Click **Save** and save the C2V file to a required directory. Send the saved C2V file to Elecard Sales at sales@elecard.com.
5. After receiving the V2C file containing license information back from Elecard Sales save the received file to a required directory. Open the **File** tab and select **Options** in the drop-down menu again. Open the **License** tab and click **Apply license update** (see Figure 4). The file selection dialog box should appear. Choose the received V2C file and click **OK**. Your application is successfully activated.
2. Getting Started

The following section details the procedures for installing and running Elecard StreamEye.

2.1 Installing Elecard StreamEye

Elecard StreamEye is supplied as part of Elecard StreamEye Studio or as a full-featured or basic standalone application. The application is installed via Elecard StreamEye Studio installer.

Depending on the purchased product or version, the installation file is located:

- in /opt/Elecard/StreamEye/bin folder as a separate application (StreamEye Basic or StreamEye);
- in /opt/Elecard/ Elecard StreamEye Studio/StreamEye/bin folder as part of Elecard StreamEye Studio.

The console is located in /opt/Elecard/StreamEye/bin folder.

To install Elecard StreamEye on Linux OS, follow the steps below:

- Install the StreamEye software by running the StreamEye-4.x-Linux.deb file.
- Install Sentinel Runtime (Sentinel License Manager allows using the license).

2.2 Uninstalling Elecard StreamEye

Elecard StreamEye can be uninstalled as a part of Elecard StreamEye Studio or as a standalone application.

Depending on the operating system, there are two options of uninstalling the application.

1. To delete the Elecard application from Ubuntu:
   - Enter the command in the terminal: `sudo apt remove <application>`;
   - Or using the Ubuntu Software icon:
     - When Ubuntu Software opens, click the Installed button at the top.
     - Select the application that you want to delete, click Remove and Confirm the application remove.
     - You will be asked to authenticate by entering your password. After authentication the application will be removed.

2. To delete the Elecard application from CentOS:
   - Enter the command in the terminal: `sudo yum remove <application>`.

2.3 Running Elecard StreamEye

To run Elecard StreamEye as a part of StreamEye Studio, click Menu → Applications → Elecard StreamEye Studio → Elecard StreamEye X.X.

To run Elecard StreamEye click Menu → Applications → Elecard StreamEye X.X.
3. Describing Elecard StreamEye

3.1 Overview


With navigation down to the deepest levels of an encoded stream StreamEye products enable powerful and efficient debug for development of MPEG-1/2, AVC, HEVC, VP9, AV1 video codec. Detailed display of information includes frames types and sizes, coded units’ data, visualization of slice and tile boundaries, partition, motion vectors, types, bit sizes, quantizers etc.

Note, that full featured version of Elecard StreamEye contains all the above-mentioned features and provides more accurate configurations for the overlay and additional customizable options. Moreover, it allows viewing reference data and comparing the analysis results with it, calculating the selected metrics, using command line and other additional options and parameters, which are not available in the Basic version.

3.2 Specifications

Elecard StreamEye supports the following formats (depends on the license purchased):

- MPEG-1 Video stream,
- MPEG-2 Video stream,
- AVC/H.264 Video stream,
- HEVC/H.265 Video stream,
- VP9 Video stream,
- AV1 Video stream,
- MPEG-2 Transport Stream (MPEG-1/2, AVC, HEVC),
- MPEG-2 Program Stream (MPEG-1/2, AVC, HEVC),
- AVI file container (MPEG-1/2, AVC, HEVC),
- MP4 file container (MPEG-1/2, AVC, HEVC, VP9, AV1),
- MKV file container (MPEG-1/2, AVC, HEVC, VP9, AV1),
- WebM file container based on MKV (VP9, AV1),
- IVF file container (VP9, AV1),
- FLV file container (AVC).

3.3 Features

Both versions of Elecard StreamEye provide the following features (depends on the license purchased):

- Display and saving of stream summary and picture information.
- Display of decoded, predicted, and unfiltered frame data (YUV or single component).
- Display of residual, transform, and dequantized coefficients.
- Saving of decoded, predicted, unfiltered and residual information.
- Display of Macroblock (MPEG-1/2, AVC) / Coding Tree Unit (HEVC) / Super Block (VP9,
AV1) data: location, slice index, tile index, sizes, coded, prediction, transform unit info.

- Navigation via BarChart.
- Stream navigation and display in I, P, B, IP and Key Frames modes.
- Stream viewer – file content (header level) presentation in text mode.
- Hex viewer.

**Full featured version of Elecard StreamEye provides the following features (depends on the license purchased):**

- Display of bitstream headers with offsets and bit size indication (as in the Standard documentation) for all standards.
- Visualization of slice and tile boundaries, partition, motion vectors, types, bit sizes, quantizers.
- Navigation via thumbnails or AreaChart.
- Display of bit distribution inside video stream. Ability to choose bitstream elements to display.
- Display of reference frames.
- Sharing comments between application instances and/or applications of Elecard StreamEye Studio set.
- Synchronization between applications of Elecard StreamEye Studio set (Binding mode).
- Display of Decoded Picture Buffer (DBP) information.
- Analysis and display of the Decoder Video Buffer parameters.
- Command line tool.
- Viewing of reference raw data.
- Metrics calculation.
- Visual comparison with reference raw data (Temperature, Subtraction, Compare, Block PSNR modes).
- EPSNR\(^1\) calculation.

**Note 1:** E-PSNR (Estimated Peak Signal to Noise Ratio) metric measures PSNR values from encoded video sequence without reference video sequence. Encoded stream data — sequence and picture headers information, macroblock types, quantization parameters and other information from the stream is used during the calculation. In almost all cases this information is enough to retrieve PSNR values very precisely, though mismatches might happen in some rare situations.
4. Using Elecard StreamEye

4.1 Introduction

The following section describes the Elecard StreamEye program GUI. The Elecard StreamEye program has a simple user-friendly interface that allows the user to perform a number of operations including: opening media stream for analysis, visualization and saving of various information, stream navigation, etc.

4.2 Describing Elecard StreamEye GUI

The following section describes the Elecard StreamEye GUI.

![Elecard StreamEye GUI - Main Window](image)

Figure 5. Elecard StreamEye GUI – Main Window

4.2.1 ToolBars

The following table describes the Elecard StreamEye toolbars.

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Open file</strong></td>
<td>![Icon]</td>
<td>Opens a media file for analysis.</td>
</tr>
<tr>
<td><strong>Reopen</strong></td>
<td>![Icon]</td>
<td>Reopens a list of recently opened files.</td>
</tr>
<tr>
<td><strong>Reopen Last File</strong></td>
<td>![Icon]</td>
<td>Reopens the last opened file.</td>
</tr>
</tbody>
</table>
Save | Saves stream, picture, headers, index, buffer, block info, YUV data (decoded, predicted, unfiltered, residual), image (decoded, predicted, unfiltered, residual, difference).
---|---
Close | Closes the file.
Binding | Enables or disables the Binding mode:
| • Leader – allows sending comments, commands on interface or positioning changes to other applications;
| • Follower – allows receiving comments, commands from other applications.
Open comments | Opens comments from the XML file.
Save comments | Saves comments to the XML file.
Open with | Opens the current file with an external application (the application name and its path are set in the Open With List field by opening Options – Main. Player is set by default).
Options | Opens the program settings dialog.
Exit | Exits the application.

**Reference (Full version only)**

Open reference | Opens reference stream (raw YUV data).
Reopen reference | Opens the recently opened reference stream.
Pin | Opens the raw data stream automatically, if the media stream is opened.
Pin type | Always opens raw data stream if enabled.
Reference configuration | Allows configuring the reference frame.

**View**

BarChart | Sets the BarChart presentation parameters:
| • Presentation Order - changes the display sequence of frames on the BarChart: stream or display order.
| • Scale - sets bar width (1, 2, 8, 32 and 64 pixels). If 32 or 64 pixels are selected, thumbnails line is displayed.
| • Bit allocation Lines – number of bits that are conveyed or processed per a unit of time.
| • Reference marker - circles visualize reference list for the selected frame (red – L0, green – L1). Hover a cursor over the frame with reference marker, the corresponding PUs are highlighted in the video out panel. And vice versa, if PU is pointed in the video out panel, the corresponding reference markers are highlighted (on the previous figure the PU with Bidirectional prediction L0=0, L1=0 is selected).
| • Sizes - visualizes bit distribution in the stream according to the following groups: transform, intra prediction, inter prediction.
| • Metrics - visualizes results of metrics calculated from a reference stream.
| • Quantizers - visualizes the frame mean quantizer value (blue line).
| • EPSNR (Full version only) - visualizes E-PSNR metrics values on the BarChart (for MPEG-2 and AVC only).
| • DPB Occupancy - visualizes the number of frames contained in DPB decoder.
| • Thumbnails on Tooltip - shows / hides thumbnails on the BarChart. Graphic Mode decreases the BarChart brightness to focus on graphics. This option is switched on by default.
Scale | Sets the video scaling coefficient: x0.125, x0.25, x0.5, x1, x2, x4, x8
Chroma format | Selects displayable color space: YUV, Y, U, V.
Difference | (Full version only). Enables/disables the difference mode.
Difference | (Full version only). Enables/disables the comparison. The combo-boxes Difference
The following Difference modes are available:

- **Compare** – pixel-by-pixel comparison of two frames. If two pixels are matched, the result is 0. Otherwise the result is equal to the maximum value.
- **PSNR** – the result is the PSNR values (from 0 to 99.99) for corresponding CU partitioning blocks, where black color corresponds to 0 value, and white color corresponds to the value of 99.99 and higher.
- **PSNR Clip** – the same as the PSNR, but minimum result value is the minimal PSNR among all blocks in the frame and maximum – the maximal PSNR, respectively. Black color corresponds to minimal value, white color corresponds to maximal value, and blended colors correspond to intermediate values.
- **Subtraction** – pixel-by-pixel subtraction. The result is equal to the difference value.
- **Temperature** – absolute difference (pixel-by-pixel subtraction), results are highlighted (black-blue-green-red), where black corresponds to zero difference, blue corresponds to slight difference, green corresponds to medium difference and red corresponds to the biggest difference.

The following Source 0, Source 1 values are available: Decoded, Predicted, Unfiltered, Reference, Memory.

<table>
<thead>
<tr>
<th>Memory</th>
<th>(Full version only). Memorizes the selected frame for use in the Difference analysis.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source 0</td>
<td>(Full version only). Allows selecting the first source for further difference calculation</td>
</tr>
<tr>
<td>Source 1</td>
<td>(Full version only). Allows selecting the second source for further difference calculation</td>
</tr>
<tr>
<td>Navigation</td>
<td>Allows displaying or activating the BarChart, Thumbnails, AreaChart panels.</td>
</tr>
<tr>
<td>Output</td>
<td>Allows displaying or activating the Decoded, Predicted, Unfiltered, Residual, Reference, Difference, Memory picture output types.</td>
</tr>
<tr>
<td>Info</td>
<td>Allows displaying or activating the Stream, Picture, Headers, DPB, Block Info, Block Presenter, Statistics panels.</td>
</tr>
<tr>
<td>Tools</td>
<td>Allows displaying or activating the Stream Viewer, HEX Viewer, Pixels, Message, Buffer, Overlay panels.</td>
</tr>
<tr>
<td>Show/Hide</td>
<td>Allows showing/hiding all panels except output pictures.</td>
</tr>
<tr>
<td>Show All</td>
<td>Shows all panels.</td>
</tr>
<tr>
<td>Hide All</td>
<td>Hide all panels.</td>
</tr>
</tbody>
</table>

**Toolbars**

- Allows selecting the toolbars to be displayed: File, Reference, View, Overlays, Navigation, Help

**Layouts**

- Allows displaying the selected layouts: View modes from 0 to 3.

**Visualization**

- **Cursor mode**
  - Selects auxiliary info to display with marker in the video out panel:
    - **Partitions** – displays grid and borders of macroblock types;
    - **Types** – displays CU type;
    - **MVs** – displays motion vectors
    - **Tooltip** – displays tooltip with block info
    - **Tooltip config** – allows selecting parameters displayed in the tooltip (General, Sizes, Transform, Prediction)
    - **Metric** – calculate metric for the selected block and display the metric values in the status bar
    - **Metric Config** – selects type: PSNR, residual sum of squares, color component (Y, U, V, YUV) and sources for metric calculation (decoded, predicted, unfiltered, reference, memory)

- **Slice Boundaries**
  - Displays subdivision into slices and tiles. (Full version is customizable, Basic version allows only enabling/disabling the option).

- **Partitions**
  - Displays prediction and transform units. (Full version is customizable, Basic version allows only enabling/disabling the option).
### Motion Vectors
Displays intra and inter prediction mode, motion vectors, text. (Full version is customizable, Basic version allows only enabling/disabling the option).

### Types
Displays CU types. (Full version is customizable, Basic version allows only enabling/disabling the option).

### Sizes
Displays sizes corresponding to CTU, CU, PU, TU, text. (Full version is customizable, Basic version allows only enabling/disabling the option).

### Extended
Displays extended parameters including: Quant, Quant text and SAO (for HEVC only).

### Filter
(Full version only). Displays the applied filters:
- Interlace (frame) – specifies what interlaced frame should be used.
- Interlace config – specifies the type of the interlaced frame which should be used. These filters are available only for interlaced frames.
- HDR – SDR – displays HDR content on SDR screen (experimental). The filter is available only for AVC, HEVC and 10bit streams.

### Navigation Controls
To set the stream position to a frame, click the corresponding navigation control: BarChart, Thumbnails, AreaChart. The bit allocation, quant, metrics and E-PSNR values are displayed on the AreaChart as well as on the BarChart.

Hover a cursor over a frame, the frame detailed info is displayed.

### Navigation
- **Go to begin**
  - Go to beginning - sets the current position to the first frame in the stream.
- **Step backward**
  - Previous - sets the current position to the previous frame.
- **Play**
  - Play - starts the stream playback.
- **Step forward**
  - Next - sets the current position to the next frame.
- **Go to end**
  - Go to end - sets the current position to the last frame in the stream.
- **Fast play**
  - Fast play - starts fast playback of the stream.
- **Step order**
  - Selects the frame jump mode. The following options are available: Stream, Display, I frame, P Frame, B frame, IP frame, Key frame.
- **Find...**
  - Opens the Search dialog with search options by stream\display order, time, offset.

### Help
- **Contents**
  - Opens the current User Guide in .pdf format
- **Feedback**
  - Sends the StreamEye feedback via e-mail, if it is registered in the system with the following subjects: Submit an Idea, Ask a Question, Report a Bug.
- **About**
  - Shows the About window.

### 4.2.2 Navigation Controls

To set the stream position to a frame, click the corresponding navigation control: BarChart, Thumbnails, AreaChart. The bit allocation, quant, metrics and E-PSNR values are displayed on the AreaChart as well as on the BarChart.

Hover a cursor over a frame, the frame detailed info is displayed.
BarChart:

The BarChart navigation control shows the video stream that is currently open. The bar height illustrates the frame size (in bytes) and the bar color indicates the frame type (red – I, blue – P, green – B).

 Thumbnails (Full version only):

The Thumbnails navigation control shows the stream using the frame thumbnails. Thumbnail underline colors correspond to the frame type (red – I, blue – P, green – B). The stream/display frame order is indicated with digits below thumbnails.
AreaChart (Full version only):

Figure 9. Elecard StreamEye GUI – AreaChart Control

The AreaChart navigation control visualizes bit distribution in the video stream. The control allows choosing bitstream elements to display. The chart type (area bars) is configurable via the program settings.

Figure 10. Elecard StreamEye GUI – AreaChart Control (Alternate View)

4.2.3 Comments Panel

The Comments panel is designed for teamwork: share comments on a specific frame or group of frames in the stream, navigation and switching between different instances of the same application or different applications contained in Elecard StreamEye Studio. Comments are created in the BarChart panel of the application by left-clicking (or right-clicking and pressing the shift button) and selecting the required field.

The Comment dialog should open. Enter comments in the corresponding field.

Figure 11. Elecard StreamEye GUI – Comment dialog

The comment parameters can be edited or changed before or after they are saved. To save the comment click File -> Save Comments and select the folder. When the comment is chosen, its position is displayed in BarChart and highlighted green.
To edit, remove or send comments using the **Binding** mode, open the context menu by right-clicking. The **Send** option enables you to pass the selected comment to the other application of StreamEye Studio set or the other instance of StreamEye. To select an application from which messages should be received or to select a type of messages to be received, go to the **Options tab – Binding** or see more details in the **Options Dialog** section.

### 4.2.4 Stream Panel

The **Stream** panel displays the stream summary information: profile, compatibility flags, level, tier, chroma format, resolution, frame rate, duration, frame types, average frame sizes; range of quantizer values; bit allocation info; frame average bit distribution in CU.

![Stream Panel](Image)

**Figure 12. Stream Panel**

### 4.2.5 Stream Viewer

The stream viewer displays a structure of headers belonging to the opened stream in the text mode. The stream internal structures are expandable. Access units are separated with alternative background colors.
The panel content is synchronized with the stream position.

### 4.2.6 Message Panel

**(Full version only)**

The Message panel displays information about compliance verification of the stream against the compression standard. The Message panel supports display for HEVC video only. For unsupported video formats, nothing is displayed in this panel. Data displayed in the Message Panel is synchronized with the data displayed in Hex Viewer and Stream Viewer panels.

**Figure 14. Message Panel**

### 4.2.7 Buffer Panel

**(Full version only)**

To ensure the system operational reliability, the Decoder Video Buffer parameter analysis is performed. The Buffer panel displays results of the analysis (for AVC and HEVC video formats only). For unsupported video formats nothing is displayed in this panel. The buffer parameters are based on the SEI values. If SEI is not available, the parameters are reconstructed using the stream level/layer.

The following controls are available on the Buffer panel:
- **Mode** – sets the chart vertical scaling mode (Defined – relative to the `cpb_buffer_size` value; Actual – relative to the selected buffer minimum and maximum sizes).
- **Scale** – specifies the chart horizontal scale.
- **Left info panel** – indicates the main parameters that are used for the buffer calculation, and the selected parameter values.

![Figure 15. Buffer Panel](image)

### 4.2.8 Hex Viewer

The **hex viewer** panel contains the following information blocks:

- Offset (from the file beginning) of the line displayed in the next block.
- Part of the file data in the hexadecimal mode.
- Part of the file data in the text mode (ASCII).
- Part of the file data in the binary mode.

![Figure 16. Hex Viewer](image)

The following table describes the **hex viewer** tuning controls.

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FF</td>
<td>Enables / disables the file data presentation in a hexadecimal mode.</td>
</tr>
<tr>
<td>T</td>
<td>Enables / disables the file data presentation in a text mode (ASCII).</td>
</tr>
<tr>
<td>DI</td>
<td>Enables / disables the file data presentation in a binary mode.</td>
</tr>
</tbody>
</table>

<p>| Table 2. Hex Viewer Controls |</p>
<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns</td>
<td>Specifies the data amount (number of bytes) displayed in each line. If the Auto value is set, the lengths of lines is adjusted to the HEX viewer panel width.</td>
</tr>
<tr>
<td>☑️</td>
<td>Sets cursor position to the specified offset values.</td>
</tr>
<tr>
<td>🌟</td>
<td>Color highlighting of the values specified in the corresponding field.</td>
</tr>
</tbody>
</table>

To highlight data area intended for further copying or saving, hover a cursor, select the required data and right click it. A drop-down menu will appear. You can copy the data to clipboard or save to a file:

- **Copy to clipboard** – copies the data to clipboard in the text format which depends on the selected HEX\ASCII\BINARY mode;
- **Save to file** – saves the selected binary data to a file.

The panel content is synchronized with the stream position.

### 4.2.9 Picture Panel

The **Picture** panel displays the frame summary information: CU, PU, TU size (in bits); max\min QP; pixel distribution into encoded type (intra, inter, and skip); motion vectors range; bit distribution in CU.

![Figure 17. Picture Panel](image-url)
4.2.10 Headers

(Full version only)
The panel displays the bitstream headers that are used for the selected frame decoding and displaying (as in the Standard documentation).

Right click the required line to copy or to copy with child. The Copy function allows copying the selected line. The Copy with child function allows copying the Child record when copying the Parent record.

Hover a cursor over a parameter, a pop-up window showing information on the corresponding standard will appear.

![Figure 18. Headers Panel](image)

4.2.11 DPB Panel

(Full version only)
The DPB panel indicates the Decoded Picture Buffer information for the selected frame. The DBP panel supports display for AVC, HEVC, VP9 and AV1 video only. For unsupported video formats nothing is displayed in this panel.
4.2.12 Statistics Panel

(Full version only)

The panel displays statistics on streams and selected frames. Statistics details depend on a media file format. The common structure covered by the statistics includes distance between I frames, P Frames, B frames and Key frames.

<table>
<thead>
<tr>
<th>Statistics data can be shown either for a stream or for a picture and either by count, or by area:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Stream – displays statistics for the whole stream by:</td>
</tr>
<tr>
<td>o Structure – the most common and average values are displayed.</td>
</tr>
<tr>
<td>o Prediction – indicates percentage of various prediction types in the stream.</td>
</tr>
<tr>
<td>• Picture – depending on the stream format, statistics is displayed for each format of the selected frame:</td>
</tr>
<tr>
<td>- HEVC format:</td>
</tr>
<tr>
<td>o CU info – counts partition types and dimensions applied for Coded Units.</td>
</tr>
<tr>
<td>o PU type intra – counts Prediction Intra Types (luma\chroma) applied for Prediction Units.</td>
</tr>
<tr>
<td>o PU type inter – counts Prediction Inter Types (luma\chroma) and vectors data such as max</td>
</tr>
</tbody>
</table>
x/y, avg x/y, zero vectors count, ref_idx_0/refidx_1 lists applied for Prediction Units.
  o TU info – counts dimensions, zero sizes applied for Transform Units.
  o SAO info – shows SAO types applied for luma and chroma, using merge_up_flag and merge_left_flag.

- **AVC format:**
  o MB info – counts types & dimensions applied macroblocks.
  o Prediction type intra – counts Prediction Intra Types (luma\chroma) applied for macroblocks.
  o Prediction type inter – counts Prediction Inter Types (luma\chroma) and vectors data such as max x/y, avg x/y, zero vectors count, ref_idx_0/refidx_1 lists applied for macroblocks.
  o Transform info – counts dimensions, number of zero sizes applied for macroblocks.

- **MPEG-1/2 format:**
  o MB info – counts mb types applied for macroblocks.

- **VP9 format:**
  o Block info - counts dimensions applied for blocks.
  o Intra modes – counts prediction intra types applied for blocks
  o Inter modes – counts prediction inter types and vectors data such as max x/y, avg x/y, zero vectors count, LAST_FRAME\GOLDEN_FRAME\ALTREF_FRAME applied for blocks.

- **AV1 format:**
  o Block info - counts dimensions applied for blocks.
  o Intra modes – counts prediction intra types applied for blocks
  o Inter modes – counts prediction inter types and vectors data such as max x/y, avg x/y, zero vectors count, NEARESTMV\NEARMV\GLOBALMV\NEWMV\NEAREST_NEARESTMV\NEAREST_NEARMV\NEAREST_NEWMV\NEW_NEARESTMV\NEW_NEARESTMV\NEW_NEARMV\GLOBALLOBALMV\NEW_NEWMV applied for blocks.

### 4.2.13 Video Out Panels

The panel displays decoded information at various steps (decoded, predicted, unfiltered, residual), corresponding reference frame, and selected difference.

For decoded, predicted, and unfiltered tabs, indication (in the tab name) of PSNR calculated with reference for Average, Y, U, V is available (adjusted via the program settings).

The scroll wheel button allows the video scaling from 12.5% to 800%.

Click the selected CTU, to lock its position.

Click and drag to select an area.
Point to the selected Prediction subblock/Block in the difference (PSNR clip/decoded) tab, to display in the tooltip the PSNR values for Y, U, V components.

4.2.14 Overlay Panel

(Full version only)

The Panel is used for Overlay configuration and allows setting the required parameters.
Figure 22. Overlay Panel

- **Opacity** – transparency of the Overlay.
- **Slices / Tiles** – allows selecting color for slices and tiles display
- **Partitions** – allows selecting color for partitions display
- **Motion Vectors** - allows selecting color for motion vectors display. The range -1; -1 / -1; -1 is set by default, and disregarded. If the range is enabled and the values are set, the areas matching the stated values only are displayed.
- **Types** – allows selecting color for intra\inter one direction\inter two direction\inter direct (AVC) display
- **Sizes** – allows selecting color for block sizes display
- **Quant** – allows selecting color for quantizer display
- **Difference PSNR** – a range showing difference in PSNR blocks. The blocks not matching the specified range are not displayed.

### 4.2.15 Block Presenter Panel

The Block Presenter panel provides the selected block visualization for smooth navigation and detailed information on CU parameters.
The following table describes the Block Presenter panel controls.

Table 3. Block Presenter Panel Controls

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
</table>
| Type    | Allows selecting a processing stage of the stream:  
• Decoded  
• Predicted  
• Unfiltered  
• Residual |
| Scale   | Scaling by: x2; x4; x8; x16; Auto. If Auto mode is selected, the frame size is automatically adjusted to the control size. |
|         | Shows, hides and configures overlay parameters:  
• Partitions  
• Motion Vectors  
• Types  
• Background |
|         | Shows, hides and displays values for the selected blocks:  
• Predictions  
• Sizes  
• Quantizers |

4.2.16 Block Info Panel

The panel displays block information (Macroblock\Coding Tree Unit\Super Block – depending on the opened stream type) and includes: location, slice index, tile index; sizes; coded unit, predicted unit, transform unit info.
4.2.17 Pixels Panel

(Full version only)

The Pixels panel displays pixel YUV values for different decoding steps (decoded, predicted, unfiltered), coefficient values (residual, transform, dequantized), reference (if opened) and difference (if selected and exists).
Table 4. Pixels Panel Controls

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt=" " /></td>
<td>Allows displaying data in two windows for comparison.</td>
</tr>
<tr>
<td><img src="image" alt=" " /></td>
<td>Selects YUV components for visualization. The background color corresponds to the pixel color.</td>
</tr>
<tr>
<td><img src="image" alt=" " /></td>
<td>Snaps the reference point to the selected block on the video output.</td>
</tr>
<tr>
<td><img src="image" alt=" " /></td>
<td>Displays data in decimal/hexadecimal mode.</td>
</tr>
<tr>
<td><img src="image" alt=" " /></td>
<td>Displays partitions grid.</td>
</tr>
<tr>
<td><img src="image" alt=" " /></td>
<td>Synchronizes visualization mode according to the active tab of the Video Out panel.</td>
</tr>
</tbody>
</table>

To select visualization area left-click it. To copy data, right-click it, and the drop-down menu appears: copy subblock, copy block.

4.2.18 Options Dialog

To configure file settings, its visualization, performance, binding and saving modes, open the Options dialog by clicking the ![ ](image) button or selecting the corresponding File menu command, and choose the required tab.
The following table describes the Main tab in the Options dialog.

<table>
<thead>
<tr>
<th>Control</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Number of recent files in list</strong></td>
<td>Shows a number of recent files being saved in a list.</td>
</tr>
<tr>
<td><strong>Delete missing recent files from list automatically</strong></td>
<td>Allows deleting missing files from the recent list automatically when opening a file from the list.</td>
</tr>
<tr>
<td><strong>Always show Select Stream dialog</strong></td>
<td>Enables displaying of the Select Stream dialog on a permanent basis.</td>
</tr>
<tr>
<td><strong>Always show preview dialog when opening a reference</strong></td>
<td>Enables/disables the Preview dialog displaying when opening a stream. If the option is disabled, the stream is opened with the last used type, offset, and increment parameters.</td>
</tr>
<tr>
<td><strong>Initial buffer size 10-100 MB</strong></td>
<td>Allows specifying parser initialization buffer.</td>
</tr>
<tr>
<td><strong>Skip initial incomplete data</strong></td>
<td>Allows skipping data that precede the first basic headers:</td>
</tr>
<tr>
<td></td>
<td>• AVC: SPS, PPS;</td>
</tr>
<tr>
<td></td>
<td>• HEVC: VPS, SPS, PPS;</td>
</tr>
<tr>
<td></td>
<td>• MPEG-2: sequence_header, picture_header</td>
</tr>
<tr>
<td><strong>Indexing mode</strong></td>
<td>Starts indexing mode and allows selecting the type:</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Extended</td>
<td>Performs parsing (defines number, type, time, and basic size per each frame) and indexing (detailed statistics for frames and thumbnails is collected during indexation).</td>
</tr>
<tr>
<td>Base</td>
<td>Performs parsing only.</td>
</tr>
<tr>
<td>Calculate bitallocation by:</td>
<td></td>
</tr>
<tr>
<td>Time</td>
<td>Calculates bitallocation based on the times from a container (if available).</td>
</tr>
<tr>
<td>FrameRate</td>
<td>Calculates bitallocation based on the frame rate.</td>
</tr>
<tr>
<td>Open with list</td>
<td>Allows opening the file currently opened in StreamEye with another application (see details below).</td>
</tr>
<tr>
<td>Always repeat</td>
<td>Allows looping a media file, i.e. when the media file reaches its end, it will immediately start playing again from the beginning.</td>
</tr>
<tr>
<td>Restore defaults</td>
<td>Resets all settings up to default values.</td>
</tr>
</tbody>
</table>

The **Options Dialog** allows opening a file with an external application. To open the file currently opened in StreamEye with another application, specify its name and path in the **Open with list** field according to parameters specified there. The parameters path and shortcut are optional. If the path parameter is not specified, default application or player supporting a file format and installed in the system is opened. Each string specified in the **Open with list** field corresponds to an individual item in the menu **File – Open with**, that allows easy switching between applications or players after configuring the field.

![Options Dialog](image.jpg)

*Figure 27. Elecard StreamEye GUI – Options Dialog – Visualization Tab*
The following table describes the Visualization tab in the Options dialog.

<table>
<thead>
<tr>
<th>Control</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color theme</td>
<td>Allows selecting light (default) or dark colors of the GUI background:</td>
</tr>
<tr>
<td></td>
<td>• Default – light background of the GUI</td>
</tr>
<tr>
<td></td>
<td>• Dark – dark background of the GUI</td>
</tr>
<tr>
<td>AreaChart mode</td>
<td>Defines type of AreaChart presentation:</td>
</tr>
<tr>
<td></td>
<td>• Area – solid line</td>
</tr>
<tr>
<td></td>
<td>• Bar – columns</td>
</tr>
<tr>
<td>Difference partition mode</td>
<td>Allows choosing partition mode when calculating PSNR and PSNR Clip between</td>
</tr>
<tr>
<td></td>
<td>prediction subblocks and blocks.</td>
</tr>
<tr>
<td>Type presentation mode</td>
<td>Allows choosing between types to be displayed in the overlay: semitransparent, rectangle.</td>
</tr>
<tr>
<td>BarChart metric value</td>
<td>Allows selecting a component to be displayed on BarChart: Y, U, V, YUV.</td>
</tr>
<tr>
<td>Calculate metric value for each</td>
<td>Allow metrics calculation for the selected parameters:</td>
</tr>
<tr>
<td>frame with reference for:</td>
<td>• Decoded</td>
</tr>
<tr>
<td></td>
<td>• Predicted</td>
</tr>
<tr>
<td></td>
<td>• Unfiltered</td>
</tr>
<tr>
<td></td>
<td>• Show metric value in video window tab header – allows selecting metric values to be displayed in tab headers:</td>
</tr>
<tr>
<td></td>
<td>- Show average value</td>
</tr>
<tr>
<td></td>
<td>- Show Y value</td>
</tr>
<tr>
<td></td>
<td>- Show U value</td>
</tr>
<tr>
<td></td>
<td>- Show V value</td>
</tr>
</tbody>
</table>
The following table describes the Performance tab in the Options dialog.

<table>
<thead>
<tr>
<th>Control</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create thumbnails in parsing process</td>
<td>Enables or disables creation of thumbnails in parsing process (saves CPU’s power)</td>
</tr>
<tr>
<td>Create thumbnails when frame decoded</td>
<td>Enables or disables creation of thumbnails when frame decoded (saves CPU’s power)</td>
</tr>
<tr>
<td>HEVC decoder</td>
<td>Allows selecting a decoder for HEVC decoding: reference or Elecard.</td>
</tr>
<tr>
<td>Metric type</td>
<td>Allows selecting metric types to be calculated and displayed: Delta, MSAD, MSE, PSNR, APSNR, SSIM, VQM, VMAF, VMAF phone, and NQI.</td>
</tr>
<tr>
<td>Key frame range</td>
<td>Allows specifying a range of frames to define a key frame to refer to when positioning.</td>
</tr>
</tbody>
</table>

**Note:** Be aware of the fact that it overwhelmingly causes improper operation of positioning. You can use it only at your own risk and responsibility.
To configure the binding mode settings, open the corresponding tab. The binding mode allows exchanging information between applications contained in Elecard StreamEye Studio, selecting applications from which messages should be received, type of the messages to be received, synchronizing application window size and switching between controls. The Restore Defaults button resets all settings up to default values.
The following table describes the Save tab in the Options dialog.

Table 8. Elecard StreamEye – Options dialog – Save tab

<table>
<thead>
<tr>
<th>Control</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal separator in .csv file</td>
<td>Allows selecting decimal comma or decimal dot to separate an integer part from a fractional one of a real number.</td>
</tr>
<tr>
<td>Data delimiter in .csv file</td>
<td>Allows selecting comma or semicolon to specify boundaries in data stream.</td>
</tr>
<tr>
<td>Add distribution info to</td>
<td>Allows adding distribution info when saving a file: Stream info, Picture info, Index info.</td>
</tr>
<tr>
<td>Add metric info to Index file for</td>
<td>Allows adding metric info for the selected parameters when saving: Y component, U component, V component.</td>
</tr>
<tr>
<td>Save YUV data in wide format</td>
<td>Allows saving YUV data as planar 4:4:4 2byte per component regardless of input format.</td>
</tr>
</tbody>
</table>
Block info

Saving parameters of block information:
- Compact output – combines information in one line under the block parameters.
- Block info – sets output parameters.
- Add metric calculation – allows calculating metrics for the selected block.
- Subblock info – saves CU information
- Prediction info – saves PU information
- Transform info – saves TU information

4.2.19 Preview Dialog

(Full version only)

The section gives an overview of the Preview dialog. The window is displayed when Reference configuration menu item is selected or the †† button is clicked. If the Always show this dialog when opening a reference checkbox is set, the Preview dialog pops up automatically when opening a reference stream.

If the reference stream has not been opened, the †† button is not active. The parameter depends on the stream resolution that is currently open and cannot be changed.

![Preview Dialog](image.png)

Figure 31. Elecard StreamEye GUI – Preview Dialog

The following table describes the Preview dialog controls.

<table>
<thead>
<tr>
<th>Control</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>Displays values of a frame resolution which cannot be changed.</td>
</tr>
<tr>
<td>Type</td>
<td>Specifies the type of the YUV data during the analyzing process.</td>
</tr>
<tr>
<td>Bitdepth</td>
<td>Allows a user to specify values for some metric Types. For several Types, the value is not editable.</td>
</tr>
<tr>
<td>Starting frame</td>
<td>Allows specifying a starting frame (from the beginning of a reference stream).</td>
</tr>
<tr>
<td>Increment</td>
<td>Specifies an increment value, i.e. coefficient used for calculation of a successive frame number intended for further analysis. 1 is set by default.</td>
</tr>
<tr>
<td>Filter</td>
<td>Selects the preprocessing filter.</td>
</tr>
</tbody>
</table>
### 4.2.20 Hot Keys

For tabs, functions and modes switching press hot keys described hereto.

- **Ctrl + O** – opens a **media file**.
- **Ctrl + R** – opens the **recently opened file**.

The following hot keys combinations are used for **Navigation**:

- **Ctrl + Shift + Left** – starts the **Go to beginning** function
- **Alt + Left** – goes to the **Previous** frame
- **Ctrl + Space** – starts the **Play** function
- **Alt + Right** – goes to the **Next** frame
- **Ctrl + Shift + Right** – starts the **Go to end** function

To change **View** configuration of panel controls, use the following hot keys:

- **F2** – shows / hides **all controls**
- **F3** – shows **all** (controls)
- **F4** – hides **all** (controls)
- **F5, F6, F7, F8** – change **layout configuration**
  - **F9** – shows **top** panel controls (shows \ hides all controls being located at the top of the application).
  - **F10** – shows **bottom** panel controls (shows \ hides all controls being located at the bottom of the application).
  - **F11** – shows **left** panel controls (shows \ hides all controls being located on the left of the application).
  - **F12** – shows **right** panel controls (shows \ hides all controls being located on the right of the application).

For configuring **overlays**, use the following hot key combinations:

- **ALT+1** – shows / hides the **slice boundaries** overlay
- **ALT+2** – shows / hides the **partition** overlay
- **ALT+3** – shows / hides the **motion vectors** overlay
- **ALT+4** – shows / hides the **types** overlay
- **ALT+5** – shows / hides the **sizes** overlay
- **ALT+6** – shows / hides the **extended** overlay

The following hot keys are used for switching **Video Out Panels**:

- **CTRL+1** – activates the **decoded** panel
- **CTRL+2** – activates the **predicted** panel
- **CTRL+3** – activates the **unfiltered** panel
- **CTRL+4** – activates the **residual** panel
- **CTRL+5** – activates the **reference** panel
- **CTRL+6** – activates the **difference** panel that displays the selected difference (for instance PSNR clip or decoded)
4.2.21 Command Line Tool

(Full version only)

StreamEye Command Line tool is designed for insight into MPEG-2, H.264/AVC, H.265/HEVC, VP9 and AV1 video compression standards and ever fast quality and compliance check.

StreamEye Command Line tool allows automatic analysis of video arrays. You can customize a sequence of commands to perform your specific tasks and automate your routine tasks.

Features of Command Line Tool

- Analysis the whole array of video files automatically;
- Addressing specific and complex challenges with a few lines of commands;
- Retrieving submitted results as a text file in CSV format for easy viewing in Excel;
- Customizing a sequence of commands to perform your specific tasks;
- Accelerating and automating your regular tasks;
- Getting access to most of StreamEye functionality and resources through StreamEye Console.

Launch of Command Line Tool

StreamEye Command Line tool is located in the following path: C:\Program Files\Elecard\Elecard StreamEye Studio\Elecard StreamEye\SEyeConsole.exe.

To streamline automatic analysis of several files the following rules are introduced. They reassign input and output parameters for configuration files.

Get to the command prompt by clicking Start->Run and type 'cmd'. Then enter the command to start the application first and proceed with the command line options. In general, the syntax is as follows:

```
./streameye-cli config.xml /input test.mp4 /reference test.yuv /output test_out
```

**Note:** You should not relocate the <product> console without all the other applications of the product contained in the installation pack, otherwise the console application will not start.

Notes on the command line rules:

1. Parameters with default value are not required and can be omitted;
2. Rules for input and output file names:
   - parameter /in:<file path> in the command line overwrites the value of the tag <input/> in the configuration file;
   - parameter /out:<file prefix> in the command line overwrites the value of the tag <output/> in the configuration file;
   - if <output/> tag is missing (or not specified), output file names are formed from input file name plus suffix (if the latter is specified);
   - if output file for a tag/section is not specified, the output file name for the tag/section is formed from the name specified in the <output/> tag plus suffix depending on the name of the tag/section, e.g. ".stream.csv", ".picture.csv", etc.

List of commands

Sample Config.xml file – contains all the commands performed by the application and reflects overall operation results:

```xml
<?xml version="1.0"?>
<stream version="1">
  <input file="...">
  <output separator=";(default)" delimiter=".(default)" file="...">
```
* Upsampler types that can be used in a configuration file: I444 / I422 / IYUV / NV12 / P444 / RGB24 / RGB32 / UYVY / V210 / V400 / Y42B / YUY2 / YV12 / YV16 / YVYU / NV21 / V444.  

**List of commands** contains information on the commands and all parameters which may be used within a command, and their description.

<table>
<thead>
<tr>
<th>Table 10. List of Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Command</strong></td>
</tr>
<tr>
<td>&lt;input/&gt; file</td>
</tr>
<tr>
<td>&lt;output/&gt; separator file</td>
</tr>
<tr>
<td>&lt;reference/&gt; type filter offset</td>
</tr>
<tr>
<td>Command</td>
</tr>
<tr>
<td>-------------------</td>
</tr>
<tr>
<td>increment file</td>
</tr>
<tr>
<td>&lt;range/&gt; span</td>
</tr>
<tr>
<td>&lt;info/&gt;</td>
</tr>
<tr>
<td>&lt;stream/&gt; distribution file</td>
</tr>
<tr>
<td>&lt;picture/&gt; distribution file</td>
</tr>
<tr>
<td>&lt;prediction/&gt; file</td>
</tr>
<tr>
<td>&lt;data/&gt; type file</td>
</tr>
<tr>
<td>&lt;message/&gt; level file</td>
</tr>
<tr>
<td>&lt;header/&gt; level file</td>
</tr>
<tr>
<td>&lt;condition/&gt; parameter comparison</td>
</tr>
<tr>
<td>&lt;range/&gt; value</td>
</tr>
<tr>
<td>&lt;equal/&gt; value</td>
</tr>
<tr>
<td>&lt;less/&gt; value</td>
</tr>
<tr>
<td>&lt;more/&gt; value</td>
</tr>
<tr>
<td>&lt;not/&gt; value</td>
</tr>
<tr>
<td>&lt;index/&gt; distribution order</td>
</tr>
<tr>
<td>Command</td>
</tr>
<tr>
<td>--------------</td>
</tr>
<tr>
<td>file</td>
</tr>
<tr>
<td>&lt;metrics/&gt;</td>
</tr>
<tr>
<td>type</td>
</tr>
<tr>
<td>source</td>
</tr>
<tr>
<td>file</td>
</tr>
<tr>
<td>&lt;difference/&gt;</td>
</tr>
<tr>
<td>type</td>
</tr>
<tr>
<td>source0</td>
</tr>
<tr>
<td>source1</td>
</tr>
<tr>
<td>file</td>
</tr>
<tr>
<td>&lt;buffer/&gt;</td>
</tr>
<tr>
<td>file</td>
</tr>
<tr>
<td>&lt;block/&gt;</td>
</tr>
<tr>
<td>compact</td>
</tr>
<tr>
<td>disable</td>
</tr>
<tr>
<td>file</td>
</tr>
<tr>
<td>&lt;dpb/&gt;</td>
</tr>
<tr>
<td>description</td>
</tr>
<tr>
<td>file</td>
</tr>
</tbody>
</table>

These examples show how to perform some of the typical tasks from the command-line:

1. **Saving the general information on the stream and on each picture**
2. **Retrieving information on the number of IDR_W_RADL slices and offsets**
3. **Searching for all slices with the slice type value equal to "2"**
4. **Saving YUV data on the prediction step**
5. **Saving the block info data of the picture**
6. **Retrieving information on frame sizes and PSNR values for the first 10 frames**

1. **Saving the general information on the stream and on each picture**

   **config.xml:**

   ```xml
   <?xml version="1.0"?>
   <stream version="1">
     <input file="C:\Media\hevcbtest_12_0_sei.h265"/>
     <output file="C:\Media\hevc\out"/>
     <info>
       <stream/>
       <picture/>
     </info>
   </stream>
   ```

   **Output files:**

   **test_12_0_sei.stream.csv:**

<table>
<thead>
<tr>
<th>name</th>
<th>value</th>
</tr>
</thead>
<tbody>
<tr>
<td>stream type</td>
<td>HEVC/H.265</td>
</tr>
<tr>
<td>profile</td>
<td>Main;</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------</td>
</tr>
<tr>
<td>compatibility</td>
<td>Main; Main 10;</td>
</tr>
<tr>
<td>level / tier</td>
<td>Undefined / Main;</td>
</tr>
<tr>
<td>chroma format</td>
<td>4:2:0;</td>
</tr>
<tr>
<td>resolution</td>
<td>832 x 480;</td>
</tr>
<tr>
<td>frame rate</td>
<td>50.00;</td>
</tr>
<tr>
<td>bitrate</td>
<td>1 024 000 000;</td>
</tr>
</tbody>
</table>

... 

test_12_0_sei.picture.csv:

<table>
<thead>
<tr>
<th>Picture #0:</th>
<th>name; value;</th>
</tr>
</thead>
<tbody>
<tr>
<td>resolution</td>
<td>416 x 240;</td>
</tr>
<tr>
<td>size (bytes)</td>
<td></td>
</tr>
<tr>
<td>cu</td>
<td>21 476;</td>
</tr>
<tr>
<td>prediction</td>
<td>520;</td>
</tr>
<tr>
<td>transform</td>
<td>19 264;</td>
</tr>
<tr>
<td>qp</td>
<td></td>
</tr>
<tr>
<td>min / max</td>
<td>23 / 23;</td>
</tr>
<tr>
<td>pixels</td>
<td></td>
</tr>
<tr>
<td>count</td>
<td>99 840;</td>
</tr>
<tr>
<td>intra</td>
<td>99 840 (100.00%);</td>
</tr>
<tr>
<td>distribution (bits):</td>
<td></td>
</tr>
<tr>
<td>total</td>
<td>174 352 (100.00%);</td>
</tr>
<tr>
<td>split_cu_flag</td>
<td>297 (0.17%);</td>
</tr>
<tr>
<td>cu_skip_flag</td>
<td>0 (0.00%);</td>
</tr>
<tr>
<td>prediction</td>
<td></td>
</tr>
<tr>
<td>intra_prediction</td>
<td>16 653 (9.55%);</td>
</tr>
<tr>
<td>prediction</td>
<td></td>
</tr>
<tr>
<td>intra_prediction</td>
<td>16 653 (9.55%);</td>
</tr>
<tr>
<td>...</td>
<td></td>
</tr>
<tr>
<td>Picture #1:</td>
<td>name; value;</td>
</tr>
<tr>
<td>resolution</td>
<td>416 x 240;</td>
</tr>
<tr>
<td>size (bytes)</td>
<td></td>
</tr>
</tbody>
</table>
2. Retrieving information on the number of IDR_W_RADL slices and offsets

**config.xml:**

```xml
<?xml version="1.0"?>
<stream version="1">
  <input file="C:\Media\hevc\test_12_0_sei.h265"/>
  <output file="C:\Media\hevc\out"/>
  <info>
    <header level="parameter">
      <condition parameter="IDR_W_RADL" comparison="substring"/>
    </header>
  </info>
</stream>
```

**Output file:**

`test_12_0_sei.header.csv`:

<table>
<thead>
<tr>
<th>offset;</th>
<th>name;</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x000000AA;</td>
<td>slice_segment_layer() { IDR_W_RADL };</td>
</tr>
<tr>
<td>0x00025F47;</td>
<td>slice_segment_layer() { IDR_W_RADL };</td>
</tr>
</tbody>
</table>

3. Searching for all slices with the slice_type value equal to "2"

**config.xml:**

```xml
<?xml version="1.0"?>
<stream version="1">
  <input file="C:\Media\hevc\test_12_0_sei.h265"/>
  <output file="C:\Media\hevc\test_12_0_sei"/>
  <info>
    <header>
      <condition parameter="slice_type">
        <equal value="2"/>
      </condition>
    </header>
  </info>
</stream>
```

**Output file:**

`test_12_0_sei.header.csv`:

<table>
<thead>
<tr>
<th>offset;</th>
<th>name;</th>
<th>value</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x0000009C;</td>
<td>slice_segment_layer() { IDR_W_RADL };</td>
<td></td>
</tr>
<tr>
<td></td>
<td>first_slice_segment_in_pic_flag;</td>
<td>1;</td>
</tr>
<tr>
<td></td>
<td>no_output_of_prior_pics_flag;</td>
<td>0;</td>
</tr>
<tr>
<td></td>
<td>slice_pic_parameter_set_id;</td>
<td>0;</td>
</tr>
<tr>
<td></td>
<td>slice_type;</td>
<td>2;</td>
</tr>
</tbody>
</table>
4. Saving YUV data on the prediction step

**config.xml:**

```xml
<?xml version="1.0"?>
<stream version="1">
  <input file="C:\Media\hevc\test_12_0_sei.h265"/>
  <output file="C:\Media\hevc\out"/>
  <info>
    <data type="predicted"/>
  </info>
</stream>
```

**Output file:**

test_12_0_sei.data.416x240.yuv

5. Saving the block info data of the picture

**config.xml:**

```xml
<?xml version="1.0"?>
<stream version="1">
  <input file="C:\Media\hevc\test_12_0_sei.h265"/>
  <output file="C:\Media\hevc\out"/>
  <info>
    <block/>
  </info>
</stream>
```

**Output file:**

test_12_0_sei.block10.csv

<table>
<thead>
<tr>
<th>name</th>
<th>value</th>
</tr>
</thead>
<tbody>
<tr>
<td>lcu location</td>
<td>0x0;</td>
</tr>
</tbody>
</table>
lcu slice\tile idx; 00;
lcu size total\prediction\transform; 17\170;
cu type\location\dimension\depth; PART_2N\x2N\0x0\64\x64\0;
cu size total\prediction\transform; 17\170;
tu dimensions\qp; 64x64\35;
Pu inter dimension\merge flag\mvp_l0_flag\mvp_l1_flag; 64x64\0\0\0;
pu inter type\dimension; 2 (Pred_BI)\64\x64;
pu L0 mv\mvd; -1, 0, 1 / -1, 0;
pu L1 mv\mvd; -1, 1, 0 / -1, 1;
pu mv candidates; *[0]mvL0(0,0)\[1]mvL0(0,0)\*0]mvL1(0,0)\1]mvL1(0,0);
lcu location; 64x0;
lcu slice\tile idx; 00;

6. Retrieving information on frame sizes and PSNR values for the first 10 frames

**config.xml:**

```xml
<?xml version="1.0"?>
<stream version="1">
  <input file="C:\Media\hevc\test_12_0_sei.h265"/>
  <output file="C:\Media\hevc\out\"/>
  <reference file="C:\Media\raw\BasketballDrill_832x480_50.yuv"/>
  <range span="0-10"/>
  <info>
    <metrics type="psnr"/>
    <index distribution="off" order="display"/>
  </info>
</stream>
```

**Output file:**

test_12_0_sei.index.csv:

<table>
<thead>
<tr>
<th>stream</th>
<th>display</th>
<th>offset</th>
<th>poc</th>
<th>type</th>
<th>time</th>
<th>quant</th>
<th>psnr y</th>
</tr>
</thead>
<tbody>
<tr>
<td>0;</td>
<td>0;</td>
<td>0x00000000;</td>
<td>0;</td>
<td>I;</td>
<td>00:00:00:000;</td>
<td>32;</td>
<td>36.065069;</td>
</tr>
<tr>
<td>1;</td>
<td>8;</td>
<td>0x000042B3;</td>
<td>8;</td>
<td>B;</td>
<td>00:00:00:160;</td>
<td>33;</td>
<td>36.065069;</td>
</tr>
<tr>
<td>2;</td>
<td>4;</td>
<td>0x00005790;</td>
<td>4;</td>
<td>B;</td>
<td>00:00:00:160;</td>
<td>34;</td>
<td>36.065069;</td>
</tr>
<tr>
<td>...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10;</td>
<td>12;</td>
<td>0x00008343;</td>
<td>12;</td>
<td>B;</td>
<td>00:00:00:240;</td>
<td>34;</td>
<td>34.808986;</td>
</tr>
</tbody>
</table>

**4.2.22 Comparison Table**

The following table describes differences between Elecard StreamEye (Full version) and Elecard StreamEye Basic.

<table>
<thead>
<tr>
<th>Table 11. Elecard StreamEye – Comparison Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>StreamEye (Full version)</td>
</tr>
<tr>
<td>Features</td>
</tr>
<tr>
<td>--------------------------</td>
</tr>
<tr>
<td>Video Formats</td>
</tr>
<tr>
<td>Reference / Raw file support</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Tools</td>
</tr>
<tr>
<td>---</td>
</tr>
<tr>
<td>Helpful instruments addressing specific areas of investigation during bitstream analysis</td>
</tr>
<tr>
<td><strong>CU.</strong></td>
</tr>
<tr>
<td><strong>Block info</strong> The panel displays Macroblock /Superblock/TCU information: location, slice index, tile index; sizes; coded unit, predicted unit, transform unit info.</td>
</tr>
<tr>
<td><strong>Headers</strong> The panel displays the bitstream headers that are used for the selected frame decoding and display. Header parameter values along with indication of their compliance to the standards are shown.</td>
</tr>
<tr>
<td><strong>Prediction</strong> The panel displays prediction types distribution, the number of predictions in the frame for various CU sizes, percentage of prediction types in the stream, the prediction mean (for pixel) deviation from the decoded picture, that characterizes the prediction quality.</td>
</tr>
<tr>
<td><strong>DPB info</strong> The panel shows the Decoded Picture Buffer information for the selected frame. The DBP panel supports display for AVC and HEVC video.</td>
</tr>
<tr>
<td><strong>Block Presenter</strong> The panel provides block visualization for smooth navigation and detailed information on CU parameters. Shows processing stage of a stream, overlay parameters: partitions, motion vectors, types, background; values for the selected block: predictions, sizes, quantizes.</td>
</tr>
<tr>
<td><strong>Statistics</strong> The panel displays statistics on streams or selected frames and can be shown either by count, or by area: distance between I frames, P Frames, B frames and Key frames; macroblock types and dimensions, prediction and transform info and additional information depending on the stream type.</td>
</tr>
<tr>
<td><strong>Stream Viewer</strong> The stream viewer displays a structure of headers belonging to the opened stream in the text mode. The stream internal structures are expandable.</td>
</tr>
<tr>
<td><strong>HEX Viewer</strong> The viewer displays a stream in the HEX mode. The display is synchronized with the stream position.</td>
</tr>
<tr>
<td><strong>Pixels Viewer</strong> The viewer displays pixel YUV values for different decoding steps (decoded, predicted, unfiltered), coefficient values (residual, transform, dequantized), reference (if opened) and difference (if selected and exists).</td>
</tr>
<tr>
<td>Feature</td>
</tr>
<tr>
<td>-------------------------------</td>
</tr>
<tr>
<td><strong>Message Viewer</strong></td>
</tr>
<tr>
<td><strong>Buffer Analyzer</strong></td>
</tr>
<tr>
<td><strong>Picture difference comparison</strong></td>
</tr>
<tr>
<td><strong>Memory</strong></td>
</tr>
<tr>
<td><strong>Overlay Config</strong></td>
</tr>
<tr>
<td><strong>Slice boundaries:</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Partitions:</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Sizes:</strong></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

**Note:** Not available features are marked as such.
| Command line tool | **Extended:**  
Quant  
Quant Text  
SAO  
*Customizable* | Quant is On by default |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Applied filters</strong></td>
<td>Automatic statistics gathering for selected video arrays; customization of the configuration file</td>
<td></td>
</tr>
</tbody>
</table>
- Analysis the whole array of video files automatically;  
- Saving of submitted results as a text file in CSV format for easy viewing in Excel;  
- Customization of a sequence of commands to perform your specific tasks;  
- Acceleration and automation of your regular tasks; | Not available |
| **Navigation** | **Quick positioning via the stream** | Play, Stop, Go to beginning, Go to end, Fast play, One frame forward, Jump to frame by frame type |
| **Search** | Video display in the specified interlace mode or level of contrast/color richness. | Interlace  
Interlace config  
HDR – SDR (experimental) | Not available |

*Extended: Quant Text and SAO are customizable.*